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The color and the appearance may differ depending on the product, 
and the specifications are subject to change

without prior notice to improve the performance.
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Safety Instructions
These safety instructions must be followed to ensure your safety and prevent property 
damage. Make sure to read the instructions carefully and use the product in the correct 
manner.

경고 주의

경고 주의Warning Failing to follow the precautions marked with this sign, may 
result in a serious injury or even a fatality.

경고 주의

경고 주의Caution Failing to follow the precautions marked with this sign, may 
result in a personal injury or property damage.

Do not perform.

Must be followed.

Avoid connecting multiple 
electric appliances to a 
single wall outlet.

 Otherwise, it may result in • 
fire due to overheating of 
the wall outlet.

Avoid bending or twisting 
the power cord excessively 
and avoid placing heavy 
objects on the cord.

 Otherwise, it may result in • 
electric shock or fire due to 
a damaged power cord.

If the pins of the power 
plug or the wall outlet are 
covered in dust, clean it 
using a dry cloth.

 Otherwise, it may result • 
in fire.

Power Related
경고 주의

경고 주의Warning
Avoid plugging in or 
unplugging the power 
supply with wet hands.

 Otherwise, it may result in • 
electric shock.

Avoid using a damaged 
power cord or plug or a 
loose power outlet.

 Otherwise, it may result in • 
electric shock or fire.

Plug the power plug in 
firmly.

 Otherwise, it may result • 
in fire.
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2 When unplugging the 
power plug from the wall 
outlet, make sure to hold 
it by the plug and not by 
the cord.

 Otherwise, it may result in • 
electric shock or fire.

Avoid installing the product 
at an easily reachable 
height where children
may reach it.

 If a child touches the • 
product, the product may 
fall and this may result in 
injury.

경고 주의

경고 주의Caution

Installation Related
경고 주의

경고 주의Warning

Make sure to turn the power 
off and disconnect the power 
plug from the outlet before 
moving the product. Make sure 
to disconnect the connection 
cables from other devices as 
well.

 Otherwise, it may result in • 
electric shock or fire due to 
a damaged power cord.

Avoid installing the product in 
a location that is unstable or 
exposed to excessive vibrations 
such as on an unstable or 
slanted shelf.

 The product may fall and • 
this may result in damage 
to the product or injury.

 If you use the product • 
in a location exposed to 
excessive vibrations, it 
may result in a problem 
with the product or fire.

Make sure to use only the 
power cord supplied by 
our company. In addition, 
do not use the power 
cord of another electric 
appliance.

 Otherwise, it may result in • 
electric shock or fire.

Keep the power cord and 
the product away from a 
heater.

 Otherwise, it may result in • 
electric shock or fire.

Keep the plastic bags 
used to pack the product 
away from children.

 If children place the plastic • 
bags over their heads, 
they may suffocate.

If the product is installed in a 
location where the operating 
conditions vary considerably, 
a serious quality problem may 
occur due to the surrounding 
environment. In this case, 
install the product only after 
consulting one of our service 
engineers about the matter.

 Places exposed to microscopic • 
dust, chemicals, too high or low 
temperature, high humidity, such 
as airports or stations where the 
product is continuously used for a 
long time and so on.
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경고 주의

경고 주의Caution

When installing the product 
on a console or shelf, 
make sure that the front 
of the product does not 
protrude out of the console 
or shelf.

 Otherwise, this may cause • 
the product to fall off and 
result in a malfunction or 
injury.

 Make sure to use a cabinet • 
or shelf suitable to the size 
of the product.

Do not place the product 
face down on the floor.

 This may damage the • 
panel of the product.

Usage Related경고 주의

경고 주의Warning

If the product generates a 
strange noise, a burning 
smell, or smoke, unplug 
the power plug immediately 
and contact a service 
center.

 Otherwise, it may result in • 
electric shock or fire.

Do not let the product drop 
while moving it.
If you drop the product or 
the case is damaged, turn 
the power off and unplug 
the power cord. Contact a 
service center.

 Otherwise, it may result in • 
fire or electric shock.

Avoid lifting up or move the 
product by holding only the 
power cord or signal cable.

 Otherwise, it may result • 
in electric shock, fire or a 
problem with the product 
due to damage to the 
cable.

Avoid using a humidifier or 
cooker near the product.

 Otherwise, it may result in • 
electric shock or fire.

Since a high voltage 
runs through the product, 
never disassemble, repair 
or modify the product 
yourself.

 Otherwise, it may result in • 
fire or electric shock.

 If the product needs to be • 
fixed, contact a service 
center.

Disconnect the power plug 
when there is thunder or 
lightning.

 Otherwise, it may result in • 
electric shock or fire.



E
nglish

4

Avoid turning the product 
upside down or move the 
product holding only the 
stand.

 This may cause the • 
product to fall resulting in 
damage to the product or 
injury.

When a gas leak occurs, 
do not touch the product 
or the power plug and 
ventilate immediately.

 A spark may result in an • 
explosion or fire.

100

Avoid dropping an object 
over the product or cause 
impact to the product.

 Otherwise, it may result in • 
electric shock or fire.

Keep the product away 
from places exposed to oil, 
smoke or moisture; do not 
install inside a vehicle.

 Otherwise, it may result • 
in electric shock or fire. In 
particular, avoid operating 
the monitor near water or 
outdoors where it could be 
exposed to snow or rain.

Avoid inserting metal 
objects such as a 
chopsticks, coins or 
hairpins, or inflammable 
objects into the product 
(the vents, ports, etc).

 If water or an alien • 
substance enters the 
product, turn the power 
off, unplug the power cord 
and contact a service 
center. Otherwise, it may 
result in a problem with 
the product, electric shock 
or fire.

경고 주의

경고 주의Caution

Keep the small 
accessories in a location 
out of the reach of 
children.

When not using the 
product for a long time 
such as leaving your 
home, unplug the power 
cord from the wall outlet.

 Otherwise, it may cause • 
dust accumulation and 
result in fire caused by 
overheating or short circuit 
or result in an electric 
shock.
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Watching the product 
from too close a distance 
continuously may damage 
your eyesight.

 It is important to give your • 
eyes some rest (5 minutes 
every hour) when viewing 
the product screen for long 
periods of time. This will 
alleviate any eye strain.

When cleaning the product, 
do not spray water directly 
over the product parts.
Avoid spraying cleansing 
agent directly onto the 
product.

 Make sure that water does • 
not enter the product. 
Otherwise, it may result 
in fire, electric shock or a 
problem with the product.

 This may result in the • 
exterior being deformed or 
the print being removed.

When cleaning the product, 
disconnect the power cord 
and clean the product with 
the supplied cleaning cloth.

 This may result in the • 
exterior being deformed or 
the print being removed.

Since the exterior of the 
product is easily scratched, 
be sure to use the supplied 
cleansing cloth.

 However, if the cloth is • 
contaminated by alien 
substances, it may result 
in scratches to the exterior; 
therefore shake off any 
alien substances from the 
cloth before using it.

Since using a surfactant, 
which contains a large 
amount of alcohol, solvent 
or other strong chemicals, 
may result in the 
discoloration or cracking 
of the product exterior or 
the panel surface coming 
off, be sure to use the 
recommended cleansing 
agent only.

 Otherwise, this may result • 
in the discoloration and 
distortion of the structure 
and the screen surface 
may peel off.

Cleaning Related
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Touch button Description

Turn the frame on;  
Turn the frame off (touch and hold)

Access menus

Navigates or changes options on the menu.

Selects an option on the menu.

Returns to the previous menu.
(Moves to the main screen if pressed for 2 
seconds.)

Starts a slide show.

Product and Components

Power cable 
/adaptor

Digital photo 
frame

USB cable Digital frame
 stand

Quick Start Guide
/ Warranty

Please check to make sure that all of the following items are included in 
your delivered package before using the product.

Components

Name and function of each part Touch one of the operating 
buttons lightly.

Cleaning 
Cloth

User 
Manual

* Not available in all locations

Caution: While the photo frame is booting, do not press and hold the touch buttons. Touch buttons pressed 
while the photo frame is booting will not operate.

SD memory card slot
Insert the SD memory to 
view saved pictures.

USB memory 
device 
connection
Connect a USB 
storage device.

USB cable connection 
(PC connection)
Connect to a PC to copy pictures 
to the internal memory or use as a 
Mini Monitor.

Power cable connection
Connect the power cable.
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Using the Digital Frame

Connect the digital frame to a PC with the USB cable to use as a Mini 
Monitor.

Connect the digital frame to a PC with the USB cable to use as a Mini 
Monitor (aux. monitor). You must install Frame Manager on your 
PC in order to use the product as a Mini Monitor.
Log on to http://samsung.com/ to download Frame Manager and for 
instructions on using the product as a Mini Monitor.
Only one auxiliary monitor can be used at a time. 
*  The buttons on the digital photo frame are disabled (in Mass 

Storage or Mini Monitor mode) when connected to a PC.

Using as a Mini Monitor

Press [ ]. Use [▲,▼,◄,►] to 
move to the picture you 

want and press [ ].

If you press the [ ] button during a slide show, the <Home>, <Rotate>, <Zoom> and <Settings> menus will appear.
•  To use <Rotate>, <View Mode> must be set as <Photo Only>, <Photo & Clock> or <Photo & Calendar>.
•  To use <Zoom>, <View Mode> must be set as <Photo Only> or <Photo & Clock>.

PC requirements for use as a 
Mini Monitor

•  OS: Windows XP SP2, Vista 
•  USB:  Extended Host Controller(EHCT)
            USB 2.0 supported
•  RAM: 256MB or higher
•  CPU: 2.4GHz or higher

!

Viewing pictures Pictures saved in the product’s internal memory or an external 
memory device can be viewed in a wide range of options. Only 
an SD memory card or USB memory device can be used as an 
external memory device. Refer to the following page for menu 
options.

A slide show begins from 
the picture you selected.

Set up your digital frame
700T can be used by connecting to a PC via 
the USB cable (along with the auxiliary power 
cable).
However, it may not operate properly if the 
power supply in your PC is unstable. In this 
case, connect the power adapter.

Auxiliary power 
cable

USB Cable

!

Screw the digital frame stand until it is fixed 
completely to the frame.
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Menu Description
You can set various functions using buttons.

 

<Home> Moves to the main screen.     
<Copy> If an external memory device (SD memory card/ USB 

memory device) is connected to the product,
•  Copies pictures in an external memory device to the 

internal memory.
•  Copies pictures in the internal memory to an external 

memory device.
<Delete> Deletes pictures in the internal memory or an external 

memory device.
<Select Multiple 
Files>

Selects multiple files to run functions like slide show, copy, 
delete, etc.

<Select Storage 
Device>

If an external memory device (SD memory card/USB 
memory device) is connected to the product,
•  Select the internal memory or an external memory 

device (SD memory card/USB memory device).
<Settings> Moves to the Settings screen.
* If you use the MENU, select the picture and then, press the [ ] button. 

The current time configured in <Settings> - <Clock> is displayed. The 
current time setting can be erased if the power adaptor is disconnected for a 
prolonged period of time. Please keep the power adapter connected.

Connect the digital frame to a PC with the USB cable to use as a Mini Monitor.

1 Log on to http://samsung.com/ and enter the model name 
in the search field. (700T)

2 Download and decompress the appropriate firmware. 

3 Copy the decompressed ***.isp file to the SD card or USB 
memory device and connect to the digital frame.

4 Select <Settings> - <Support> - < Upgrade Software> with 
the buttons on the product. The firmware is updated.
When the update is finished, turn the digital frame off, 
remove the external memory device (SD card/USB 
memory device), and turn the digital frame on again.
You can check if the firmware version has been updated in 
<Settings> - <Support> - <Product Information>.

Download and install the latest firmware from the Samsung 
Electronics homepage.

Firmware update

Preparations for firmware 
update

•  Digital photo frame
•  Firmware file for update
•  USB memory or SD card

!
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Photos

< Slideshow Transition> Sets the slide show effects.
•  <No Effect / Fade / Blinds / Cross Comb / Mosaic / Checkerboard / 

Dissolve / Wipe / Extend / Silk / Corner Transition / Wheel / Ellipse / 
Random>

<Slideshow Speed> Sets the slide show speed.
•  <Fast / Normal / Slow>
Images of large file sizes may not be displayed at the currently configured 
slideshow speed.

<Slideshow Mode> •  <All Photos / Photos in folder / One photo>
<Slideshow Order> Sets the slide show order.

•  <Normal / Shuffle>
<View Mode> Sets the slide show display mode.

•  <Photo Only / Photo & Clock / Photo & Calendar / Multiview 1 / Multiview 
2>

<Aspect Ratio> •  <Original Fit>:A picture smaller than the screen is displayed in its original 
size and a picture bigger than the screen size is reduced in direct 
proportion to the screen size.

•  <Auto Fit>: Fits the picture in direct proportion to the screen size.
•  <Fit to Width>: Fits the picture to the screen’s horizontal width.

<Display Photo Info> Displays a picture’s file name and date of creation.

Clock

<Clock Set> Sets the current time.
<Date Format> Select the month, year, day display mode. 

(YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY)
<Time Format> Selects the time display mode (12 hours, 24 hours).
<Clock Type> Selects the clock display mode (<Clock Only>, <Clock & Calendar>).

General

<Quick Setup> Easy settings for frequently used functions.
(<View Mode>, <Slideshow Transition>, <Clock Set>, and <Startup Mode>)

<Language> Selects the OSD (on-screen display) language.
<Brightness> Adjusts the screen brightness.
< Auto Picture On/Off > Sets the screen to automatically turn on and off at certain times.
<Startup Mode> Selects the screen to be displayed when the digital frame is switched on.

•  <Home> / <Last Mode> / <Slideshow>
<Screen Saver> If there is no button operation for 10 minutes, the currently configured 

screensaver will appear.
•  <Slideshow> / <Clock>

< Frame Memory Copy> •  <Original Size>: Copies an original file as is.
•  <Resized>: Matches the screen’s optimal resolution by reducing the file 

size and then copies.
< Activate USB 

Communication>
Selects the recognition mode to be used when the digital frame is 
connected to a PC with a USB cable.
Use as a removable disk or Mini Monitor.
Use as a digital photo frame.

Support

<Upgrade Software> Updates the firmware.
<Reset> You can reset various settings to the factory default settings.

(Time setting and screen language setting excluded).
<Product Guide> Product functions guide
< Product Information> Displays product model name, firmware version, internal memory and 

copyrights.
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Troubleshooting
Check the below table first when a malfunction is suspected.

Symptoms and questions Causes and corrections
The power won’t switch on. Ensure that the power cable is correctly connected.
Spots which look like light leaking can be 
seen on the edges of the clock screen.

Black LCD panel screens by nature can have this effect, which is not 
a defect.

The time setting is wrong.
The current time setting can be erased if the power adaptor is 
disconnected for a prolonged period of time. Keep the power adaptor 
connected.

It takes a long time for images to be 
displayed after the power has been turned 
on.
It takes a long time to move from one image 
to the next.

It is recommended to reduce the picture resolution.

I can’t copy more files even when there 
is excess capacity to use in the internal 
memory.

You may be unable to copy files if the FAT section of the internal 
memory is damaged. Try again after formatting the internal memory.

I’ve connected an external memory device 
(USB memory device or SD memory card) 
but it doesn’t work.

•  700T can be used by connecting the power adapter instead of the 
USB cable.

•  Ensure that the external memory device has been connected 
properly or try formatting it.

•  Ensure that JPEG files are saved in the external memory device.
•  Abnormal picture files (0 Kbyte, broken JPEG) will not be displayed 

on the screen.
•  The connected external memory device is not supported. Try another 

storage device.

JPEG files are not displayed.

•  Progressively saved JPEG files or JPEG files saved as CMYK color 
coordinates will not be displayed.

•  Images edited by a JPEG image editor (Photoshop, Paintshop, etc.) 
may not be displayed normally. Edit the image on a PC, convert back 
to JPEG format, save, and try again.

Some pictures are not displayed as a 
slideshow.

This product can accommodate a maximum of 4,000 pictures. Any 
excess pictures will not be recognized and will not be displayed as a 
slide show.

The picture size changes when I rotate it. The picture size changes automatically depending on the rotation 
angle (90°, -90°) in order to display the entire image on the screen.

The picture looks stretched horizontally or 
vertically.

Press [ ] on the slide show screen. Go to <Settings> - <Photos> - 
<Aspect Ratio> and change the setting to <Original Fit> and check 
again.

Previews are too slow. Previews may be slow for large-sized images and multiple images.
Slide show effects are displayed when I 
have saved only one picture I want in the 
memory card or when I pause the slide 
show with multiple pictures saved in the 
memory card.

The slide show effects will be displayed automatically in order to 
protect the panel. This is not an error.

In what order are the pictures, which are 
saved in the memory card, displayed?

They are arranged according to the file names. The slide show display 
order is determined in the order of number, upper-case letter, and 
lower-case letter. Please note that a file name can have up to 255 
characters in languages that use the roman alphabet and up to 127 in 
other languages.

The slide show doesn’t start automatically. Ensure that the <Startup Mode> is set to <Slideshow> in <Settings> 
- <General>.

I have set <Auto Picture On/Off> but the 
screen doesn’t switch on automatically.

•  Ensure that the current time has been set correctly.
•  The screen will not switch on automatically if you have turned the 

digital frame off by pressing [ ] when <Auto Picture On/Off> has 
been set. The screen switches on automatically only if the power has 
been switched off automatically at the Auto Picture Off time.

The pictures I copied from a USB memory 
or SD card onto the internal memory have 
changed in resolution and file size.

This product is designed to reduce the file size of high-resolution 
pictures to fit the screen’s ideal resolution when they are copied onto 
the internal memory.
If you want to disable the settings, you can change to the original size 
by selecting <Settings> - <General> - <Frame Memory Copy>.
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The digital frame is not recognized as a 
removable disk when I connect it to a PC 
with the USB cable.

The 700T has 2 USB connectors. You must connect the USB 
connector [ ] because the digital frame will not be recognized 
as a removable disk if only the auxiliary power (DC 5V) connector is 
connected to a PC.

Product Specifications
Classification Details

Model name 700T

Panel Type 7” TFT LCD

Resolution 800 x 600

Supported format JPEG (Progressive or CMYK type pictures are not supported.) 

Internal memory 1 GB

USB Host (USB 2.0) / Device (USB 2.0)

Power 
supply

Rating External DC power supply device (12 V) 

Power consumption General: 5.3 W / Power off: Under 1 W

General Size (Width x height x depth) 200.7 x165.3 x 30.0 mm

Weight 350 g

The product design may differ according to the model, and specifications are subject to change without prior 
notice for product performance enhancement.

This device is a Class B digital apparatus.

N Recommended memory capacities for different types of memory cards: 
(The recommended memory capacities indicated below are based on our factory test and may differ depending on the 
manufacturer.)

SD Up to 2 GB

microSD Up to 2 GB

miniSD Up to 256 MB

SDHC Up to 16 GB

microSDHC Up to 8 GB

USB Up to 32 GB
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UZBEKISTAN 8-10-800-500-55-500 http://www.samsung.com

Asia Pacific

AUSTRALIA 1300 362 603 http://www.samsung.com

CHINA 400-810-5858
010-6475 1880 http://www.samsung.com

HONG KONG (852) 3698 - 4698

http://www.samsung.
com/hk
http://www.samsung.
com/hk_en/

INDIA

3030 8282
1800 110011
1800 3000 8282
1800 266 8282

http://www.samsung.com

INDONESIA 0800-112-8888 http://www.samsung.com

JAPAN 0120-327-527 http://www.samsung.com

MALAYSIA 1800-88-9999 http://www.samsung.com

NEW ZEALAND 0800 SAMSUNG (0800 726 786) http://www.samsung.com

PHILIPPINES

1-800-10-SAMSUNG (726-7864) 
1-800-3-SAMSUNG (726-7864)
1-800-8-SAMSUNG (726-7864) 
02-5805777

http://www.samsung.com

SINGAPORE 1800-SAMSUNG(726-7864) http://www.samsung.com

TAIWAN 0800-329-999 http://www.samsung.com

THAILAND 1800-29-3232
02-689-3232 http://www.samsung.com

VIETNAM 1 800 588 889 http://www.samsung.com

Middle East & Africa

BAHRAIN 8000-4726 -

JORDAN 800-22273 -

SOUTH AFRICA 0860-SAMSUNG(726-7864) http://www.samsung.com

TURKEY 444 77 11 http://www.samsung.com

U.A.E 800-SAMSUNG(726-7864) http://www.samsung.com
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